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SPLASH 
 
SPLASH provides a powerful interface to science data. It is designed for ease of use in viewing and analyzing data and is set 
in a familiar windows-like environment. Features include the ability to read, load, and view data, create publishing quality 
plots, and perform data analysis 
 
SPLASH was developed at UCLA and can be downloaded from the PDS and VMO websites. 
 

1  Main Window Overview 
 
The main SPLASH window is shown below in Figure 1.1. This is a snapshot of the window when SPLASH is first started. 
Since no data or SPLASH document has been loaded and no plots created, the main graph area will be blank. 
 
Starting from the top of the window is the windows frame titled. SPLASH. It has the standard window features in the frame 
to minimize, maximize, and close the window. 
 
Below the frame is the main menu bar. Commonly used menus include File, Edit, View, Window, and Help. Specific to the 
SPLASH application are Graph and Analysis pull down menus. 
 
Next, below the main menu bar is the toolbar. For quick and easy access to the most frequently used functions, the toolbar 
contains icon buttons the user can click on versus navigating through the pull down menu hierarchy.  All icon buttons in the 
toolbar contain tooltips to provide the user with a brief description of the functionality.  
 
Below this is the horizontal scroll bar, which allows you to pan left and right along the x-axis of any displayed data.. 
 
The large central area of the main window contains the graph area and is where plots are displayed.  
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Figure 1.1 
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1.1 Pull Down Menus  
 
Pull down menus use standard features that users are familiar with and including the following: 
 
Sensitive:  A menu item may be sensitized or desensitized (grayed out) depending on the state of SPLASH and/or the 
availability of an operation at the time it is requested.  
 
Checked:  Check marked menu items are used when an option can be turned on or off. The check mark allows the user to 
toggle on or off an item.  
 
Sub:  In cases where multiple options are available, a sub-menu is used to further divide the functionality.  Sub-menus will 
have a carrot or arrow head indicating there are additional options to select from. 
 
Dynamic:  One menu, the Page menu, is not static and changes with the number of pages that have been created.  
 
Pop-Up:  In cases where a menu item displays another window, the name of the item will be following by three periods.   
 
Accelerator:  Some menus have accelerator keys associated with them. Accelerator keys provide a quick and easy way to 
invoke functions. When a menu item has an accelerator key, the key combination will be listed next to the name of the menu 
item.  
 
An example pull down menu is shown below in Figure 1.2.  
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1.2 Toolbar icons 
 
The toolbar provides short cuts to more commonly used functions. The buttons contain familiar icons depicting the operation. 
In addition, each tool bar button contains a tool tip that is displayed when the cursor hovers over the button. The tool tip 
displays text describing the function of the button. Figure 1.3 shows a picture of the tool bar.  
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1.3 Graph Area 
 
Shown below, in Figure 1.4, is an example of the main graph area with a graph plotted.  

 

 
 

Figure 1.4 
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1.4 Buttons 
 
In order to provide a consistent interface throughout SPLASH, you will find most windows contain the set of buttons shown 
in Figure 1.5.  

Figure 1.5 

 
 
OK: When this button is clicked whatever changes you made since the window was first displayed will be made, 
i.e.committed within the system. The window will be closed and the main graph area will be updated to reflect the changes. 
Please note that when OK is selected the original settings will be lost. 
 
Apply: The apply button will update the main graph area so that you can view your changes. The window will not be closed 
and your changes will not be committed. 
 
Cancel: Whenever the cancel button  is clicked all changes made since the window was first invoked will be reset to original 
settings. The window will be closed. The main graph area will be updated to reflect it’s original state. You should note that 
like the OK button, when the cancel button is selected all changes are lost permanently.  

1.5 Windows 
A window within SPLASH refers to any windows that is opened when pull down selections are made, a tool bar button is 
clicked or other user interaction occurs. Windows have frames, titles, and minimize, maximize, and close buttons within the 
frame. Most windows are also modal. That is, the user must either click the OK or Close button, or the Cancel button ‘X’ in 
the window frame before control is returned to the calling or original window.  
 
NOTE:  Screen size and system settings vary from machine to machine. During testing, a rare case was found that opened 
some IDL windows to size zero. The windows included the dialog box pick file and printer setup used in the File pull down 
menu. This is an error internal to IDL. If a window opens to size zero, you simply need to resize to see the content.    

1.6 Pages 
The user can have one or many pages during a session. A page contains one or many panels, titles, background color, etc. 
The number of pages that have been created can be determined by using the Page pull down menu. The Page pull down menu 
also provides a way for the user to toggle between pages since only one page can be displayed at a time. 
  

1.7 Panels 
 
A panel is a plot or graph on a page. Panels are usually contained within an axis frame and have x and y axes (and z axes for 
spectral data), traces, ticks, gridlines, and other features. One or many panels can be created per page.  
 

2 Mouse and Keyboard Events 

2.1 Tracking 
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When tracking is enabled any movement within the frame of a panel in the draw area will be tracked. Tracking can be 
toggled on and off from the Graph pull down menu. The user can choose to track one panel or all panels. In addition the user 
can track vertically, horizontally or both. When SPLASH session is first started, tracking of all panels is on by default and 
tracking vertically. Figure 2.1 shows an example of the main graph area when tracking is turned on and tracking all panels.  
Changing the tracking settings will affect what information is displayed in the legend, and which panels the legend is 
displayed on. 

 

Vertical Tracking 
Lines 
 

Position 
Legends 

 Figure 2.1 

2.2 Position Legend 
The Position Legend is the box in the upper right hand corner of each panel displayed in the ‘active’ page. The legend box 
displays a value for each variable within the panel. The value displayed is the value at the point where the vertical tracking 
line intersects the data line, in other words the x value of the data at the x position of the cursor. Whenever the cursor is 
moved the values in the legend box will be updated. Note that along with the y-axis labels, the legend labels and values are 
color-coded and synchronized with the color of the line within the plot. Figure 2.1 above shows an example of the legend 
box. 
 
The legend box is only on when tracking is enabled.  
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It is worth noting that when a page is sent to a print device, the legend will not appear in the hard copy so that the area 
covered by the legend box can be seen. 

2.3 Mouse Clicks 
 
The mouse button offers several ways to interact with SPLASH and the graph area. Mouse clicks include Single Click (left 
button), Right Click, Ctrl-Click-Drag, and Click-Drag. 
 
Single Click: 
There are two possible events that a single click will generate. One is when marker(s) are present and the user clicks within 
the highlighted area of a marker, the other is when the user clicks outside of a marker but within the graph area. Markers will 
be explained shortly in Section 2.5. For now, we will describe a single click in the graph area, which brings up a graph 
options menu window. Which graph options window is displayed depends on where within the graph area the mouse button 
was depressed.  
 
There are 5 options. 
 

Page: Any area that is outside of a panel, axis, label, or variable display will bring up the Page Options Window. In 
the event SPLASH cannot determine which object was clicked, the Page Options Window will be opened. 
X-Axis: When the user clicks on the X Axis the Axis Options panel is displayed. 
Y-Axis: When the user clicks on the X Axis the Axis Options panel is displayed. 
Variables: If variables are present the user can click in the variable display area to open the Variable Options 
window. 
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Single Click in 
 Y Axis region 

Brings up Y Axis 
Options window 
 

 Figure 2.3a 
 
Please note that resolution and screen size vary between machines and platforms. If you click close to another option in the 
draw and do not get the window you wanted, try clicking more in the middle of the area you want. 
 
Right Click: 
Clicking the right mouse button will bring up a context menu containing the most commonly used options associated with 
plotting and data analysis.  The context menu contains the following menu items. 
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Context Menu 

Right Click 

 
 Figure 2.3b 
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2.4 Keyboard Events 
 
There are two kinds of keyboard events, scrolling and expanding/reducing.   
 
Scroll: The user can scroll the panels in the active page forward or backward by using the left and right arrow keys. The plot 
will be moved forward or backward in time by one major tick length. 
 
Reduce/Expand: The panels can also be reduced or expanded by using Backspace or Tab keys. Tab will expand the panels 
horizontally by two major tick lengths (one major tick length is added to both the left and right sides of the x axis). Similarly, 
Backspace will reduce the panels displayed by two major tick lengths.  
 
Accelerator Keys: Standard accelerator keys are available for the more frequently used functions. Accelerator keys include 
 

Ctrl-O – Opens an existing SPLASH Document 
Ctrl-S – Saves a SPLASH Document 
Ctrl-Z – Close page 
Ctrl-P – Print page 
Ctrl-Q - Quit 
Ctrl-C - Copy 

 

2.5 Markers 
 
Markers allow the user to mark or select regions of interest in panels on the active page. If tracking is set for all panels then 
all panels will be marked. Likewise, if only one panel tracking is set, then only the panel the cursor is in is marked. Marker 
ranges are selected horizontally or along the x-axis, using the vertical tracking line as the boundary.  The y-axis range is 
preserved.  
 
A Ctrl-Click-Drag operation is used to create a marker. To do this, hold the Ctrl key while depressing the mouse button and 
dragging the mouse. The user can click the mouse button or the Ctrl key in any order, marking will not start until the Ctrl key 
is pressed and cursor movement is detected. Marking ends when the user releases the mouse button.  When you are finished, 
the marked area will be highlighted.  If the cursor leaves the draw area, marking will be canceled. Figure 2.4 shows examples 
of two markers, one created while all panels were being tracked, the other with only one panel tracking.  
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Marker 

Selected Marker 

 Figure 2.4 
 
 
There are several things worth noting about the marked regions shown in Figure 2.4.  
 
When a marker is ‘active’ (pink boundary lines) there are additional functions you can perform on the marker. You can 
choose to delete the marker or zoom into the marked area.  
 
To delete a marker select the Delete Marker option under the Edit pull down menu. 
 
To display only the marked area, select the Subset option under the Edit pull down menu. A new page will be created and 
displayed containing only the marked area. The original page is preserved. You can use the Window pull down menu to see 
your new page name and to move between pages or back to the original page. Marked areas are preserved and will not be lost 
when navigating between pages. 
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2.6 Data Zoom 
 
Besides zooming in on marked areas, the user can also click and drag the mouse to zoom into a selected area. While markers 
and expand/reduce preserve the y axis range, the click and drag does not.  
 
To zoom into an area depress the mouse button and drag the cursor. You will note that as you move the cursor and 
rectangular area is drawn on the panels. A corner of the rectangle is pinned as soon as you press the mouse button and cursor 
motion is detected. This rectangle is referred to as a rubber band box and can be moved in any direction. If the cursor leaves 
the draw area the zoom will be canceled. Figure 2.5a shows an example of a selected area. 

 

 
 

Figure 2.5a 

 
Once you are happy with the area you have selected you can release the mouse button. When the mouse button is released a 
new page will be created and the panel(s) redrawn using the x range contained in the rectangular area.  Similar to the Subset 
Marker option, the original page prior to the zoom operation is preserved. The Page pull down menu on the main SPLASH 
allows you to toggle between the two pages.  Figure 2.5b shows the new page that was zoomed into.  
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 Figure 2.5b 
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3  File Menu 
 
The file menu contains selections that are related to loading, saving, and managing data, as well as printing and exporting 
image files. Figure 3.1 shows all options in the File pull down menu.  The left hand menu is the menu when there is no data 
loaded, when you first open SPLASH.  The right hand menu is visible when there is data loaded. 
 

         
Figure 3.1 

 

3.1 New/New SPLASH Document… 
 
SPLASH can open many different types of data files.  It is compatible with the following formats:  
 - Plain ASCII 
 - PDS Label 
 - TECPLOT 
 - CDF 
 - UCLA Upper Flat File 
 - UCLA Lower Flat File 
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If you choose File-> New, a file picker dialog will appear.  Its appearance and exact functionality will depend on your 
platform; on Windows XP, this is what it looks like: 
 

Figure 3.2 
 
 
Navigate to the file you wish to open, and click "Open" (or perhaps "OK", depending on your platform).  In the case of CDF, 
FlatFile, PDS Labels and TECPLOT files, this will trigger the data to be loaded and the LAYOUT window will be displayed.  
The LAYOUT window is discussed in section 6.9..   
 
If you are loading an ASCII file, SPLASH will display a window, seen in Figure 3.3,  asking about the format of your file.    
The dialog will collect information about the delimiter between columns, comment format, and the number of header lines.  
Fill this out and hit okay.  Information entered will be saved for the next time you open a file.   
 
SPLASH will then attempt to read the column names of your file.  The header line with column names should have the same 
number of columns as there are columns in SPLASH.  NOTE: If your column names have spaces in them, and you have 
marked space as a delimiter, SPLASH will complain because it will have too many words in the header.  If you have more 
than one header line, it assumes that the column names are in the very first line of your file, and anything after that is ignored 
and not read.  If there is no header line, and the first line of your file is numbers, SPLASH will ask if you want it to assign 
header names.  If so, it will name your columns “Field01”, “Field02”, etc.  If  not, the columns will be named with the first 
number in each column. 
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Figure 3.3 
 

 
 
Next, SPLASH will ask for more information about your ASCII file.  What is the time?  What is the time format?  SPLASH 
has a number of built in time format for you to choose from, or you can build your own custom one.  All of this is determined 
in the Data Type dialog, shown in Figure 3.4.  The first box will list all the fields found in your file.  You should specify 
which field contains the time.  If the time is spread out over many fields (e.g. there is a year field, a month field, and a day 
field) you can use the “Join with Next” button to merge them.  Then, place a check mark next to the line containing the time.  
In the Data Sample area, you can see a preview of your time selection.   
 
In the Time Format box, you can choose between a fixed, common time format or specify one of your own using a mask.  
NOTE: The BINARY time format uses seconds since 01-01-1966, NOT UNIX TIME.   
 
If you use to create a mask, simply construct the mask (adding spaces, dashes, slashes, etc as needed) using the tokens found 
under the Token button.   
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Figure 3.4 
 
If all goes well, the Layout dialog will display and you will be able to display the desired data.  For more on the Layout 
dialog, see section 6.9. 

3.2 New From URL 
 
SPLASH is also able to load files remotely via the THEMIS website or the VMO using SPASE ID’s.  SPLASH can also load 
data from any HTTP address.  If you choose “THEMIS…” from the New from URL sub-menu, you will be presented with a 
dialog like that pictured in Figure 3.5. Simply select which spacecraft, instruments, and timeframe you want, hit OK, and 
SPLASH will automatically download the data, store it to your local hard-drive, and display the Layout dialog, which will 
allow you to specify what you want to plot.  The Layout dialog is covered in section 6.9. 
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Figure 3.5 
 
If you choose New from URL and choose the SPASE or URL option, the Load From URL dialog appears, as seen in Figure 
3.6.  The text box accepts SPASE IDs or URLs.  If you are using a SPASE ID and require a start and stop time, enter them 
into the Time Range boxes.  If no time range is specified for a SPASE ID, all data available will be downloaded.  This might 
be a lot.   
 

 
 

Figure 3.6 

3.3 Open SPLASH file 
 
SPLASH includes the capability to save the state of a SPLASH session to a file we'll refer to as a "SPLASH Document" 
(with default file extension of SPH). SPH files are plain ASCII text, use the extensible markup language (XML) to represent 
properties of SPLASH objects and loaded data, and can be examined with any ASCII file editor.  Many web browsers also 
include support for viewing XML documents (although one may need to change the file extension to XML to get the browser 
to recognize the format).  
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Any loaded data associated with a SPLASH session is NOT necessarily directly stored in the SPH file; instead, the document 
contains the information necessary to read the files and perform the calculations that were initially used to load the data.  
There are some pros and cons to this approach that users should be aware of: 
 

1. SPH files are relatively small, and can be easily shared as email attachments.  Because they are plain ASCII text, 
there are no significant file format differences between different platforms, so SPH files are portable between 
systems. 

2. Opening a SPH file requires that you have access to the original data file, unless the data has been preserved therein.  
 
To open a SPH file, select "Open SPLASH File…" from the File pull-down menu.  

A file picker dialog will appear, as seen in Figure 3.2.  Again, it’s appearance and functionality will differ somewhat by 
system. 
 
Navigate to the file you wish to open, and click "Open" (or perhaps "OK", depending on your platform). 

 
This should trigger the process of loading the data specified in the SPH file you just opened; you should see a progress bar.  It 
may take several minutes to load all the data, depending on how complex a document is being loaded;  
 
If all goes well, when the data is finished loading, the main draw window should update and show the plots for the first 
SPLASH window specified in the SPH file.  Other windows saved in the SPH file should be accessible through the 
"Window" drop-down menu button.  Any errors detected while parsing the XML file or loading the data will be reported by a 
pop-up error dialog. 

 

3.4 Save  
 
When you're ready to save your plots and loaded data, click "Save " under the File pull-down menu.  All plot settings, data, 
and data operations will be saved. If this session has not yet been saved to a SPH file, a platform-specific file-saving dialog 
will appear.  On Windows XP it will look something like this: 
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 Figure 3.7 

 
 
Navigate to the directory where you'd like to save the file, select a new filename if you don't like the default, and click "Save" 
(or maybe "OK", depending on your platform). 
 
If "Save" has already been invoked, or if the current session is the result of loading a SPH file, the file picker dialog will not 
appear, and the filename from the most recent save or open operation will be used again. 
 
If the file already exists, a pop-up will appear to warn that you're about to overwrite an existing file.  If you choose to 
proceed, the "save document" routine will try to confirm that you have write permission before attempting the save.   
 
If the save attempt fails, an error message should be displayed, either in a pop-up warning dialog, or a message in the status 
area at the bottom of the main SPLASH window.   
 
Hint: The saved SPLASH file can also be used to save default plot settings. Once you have created the font, size, colors, 
grids, axes, etc. that you prefer, the save document option will preserve those values. Each subsequent time  you start a 
SPLASH session, you simply need to open the saved document to restore your preferences. 
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3.5 Save As 
 
The File->Save As… dialog also saves a SPH file.  The only difference between "Save" and  
"Save As…" is that "Save As…" always pops up a file picker dialog, allowing one to change the filename associated with 
SPLASH session.  "Save" will reuse the last filename successfully saved to, only displaying a file picker the first time 
SPLASH state is saved. 
 
See the documentation for "Save" in section 3.4 for more information about saving SPH files. 
 

3.6 Save with Data 
 
The File-> Save with Data dialog also saves a .SPH file.  The difference between the other Save options and Save with Data 
is that every data point is saved in this file.  The main benefit of this is that you do not need to have the original data file on 
hand in order to open this SPH file.  The downside is that the file can be very large.  You have the option of saving all the 
data in the original file or only those used in the current plots.  Depending on your data and your plots, this can still be a very 
large file.   
 
See the documentation for “Save” in section 3.4 for more information about saving SPH files. 
 

3.7 Close 
 
SPLASH allows the user to have multiple pages.  If you wish to close a page there are several ways this can be done. The 
first is using the File pull down menu and selecting the Close option. The currently displayed page, or the ‘active’ page will 
be closed. Other pages will still be available. The main graph area will redraw the next page up in the list, unless there are no 
more pages, in which case a blank graph area will be drawn. In addition, the Window pull down menu dynamic options will 
be updated and renumbered to reflect the change.  
 
Besides the file pull down menu, you can also select the Close option under the Page pull down menu.   
 
It should be noted that once a page is closed the settings that were associated with that page will be lost, unless you requested 
Save under the File pull down menu before you closed the page. The data that was plotted in the page still remain are 
available for analysis and plotting. Only the plot settings are deleted. 
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3.8 Open Data File 
 
SPLASH allows the user to open many data files at the same time.  It can also replace one data file with another.  This 
functionality can be accessed under the File-> Open Data File menu.  This will bring up the  Open Data File Dialog (Figure 
3.8).  Choosing the New button will open a file picker dialog (Figure 3.2) and you may choose the files you wish to add.  You 
can add multiple files in this manner.   
 
The Replace button becomes activated when you click on a file name in the list of files.  If the user clicks Replace, a file 
picker dialog will open and the user can choose a new file to replace the old one.   
 
The Delete button becomes activated when the user clicks on a file name in the list of files.  If the delete button is clicked, 
that file, and any traces associated with it, will be removed from SPLASH.  NB: There have been reports of SPLASH 
crashing when files are removed when they are still in use.  For your own good, please remove all traces that use files about 
to be removed BEFORE removing them!  Or at least save often!   
 

 
 

Figure 3.8 
 
Once all the desire files have been entered into the dialog, pressing the OK button will load these files into memory.  If they 
are ASCII files, you will have to describe each one to SPLASH (see section 3.1 on opening files for more information.) 
 

3.9 Save Data As… 

 
The "Save Data As…" dialog allows the user to select a set of variables, and save the data as ASCII (with various formatting 
options) or as a set of files in the UCLA binary "upper flat file" format.  Unlike "Save" or "Save As…", "Save Data As…" 
does not attempt to save any SPLASH objects or plotting parameters. 
 
Click "File->Save Data As…" to bring up the Select Data dialog, pictured in Figure 3.9. 



 
 

 SPLASH User’s Guide   23 

 
 Figure 3.9 
 
 
To the far left is a list of all the different data files that have been loaded into SPLASH.  In the next box, is a list of all fields 
from that fiile.  You can choose the fields you want to save, holding down the ctrl button to select multiple fields. 
 
If the "Save as Flat file" box is checked, the data will be saved in (binary) UCLA flat file format.  For further information 
about this format, please consult the UCLA documentation. 
 
If the “Save as Tecplot” option is selected, a Tecplot-compatible .dat file will be produced with one line of field names, and 
another line with a sample count and some other information. 
 
If the "Save as ASCII data file" box is checked, the data will be saved as ASCII, one line per record.  If this format is 
selected, there are additional choices for how the ASCII data is formatted.  The "Time Format" drop-down menu brings up a 
list of different formats for representing timestamps with varying degrees of precision.  The "Floating Point Format" drop-
down menu specifies the precision and format of floating point quantities that are not internally marked as timestamps. 
 
SPLASH will automatically put the field name of each field as the header of the file.   
 
The "Indicate flags with:" text box allows the user to choose what gets printed if an IEEE-754 "NaN", "Inf", or other non-
numeric floating point value is encountered during the conversion to ASCII.   
 
Caveats: 
 
This dialog does not permit saving arbitrary collections of variables.  Owing to the record-oriented structure of these file 
formats, all selected variables must contain the same number of samples.  For UCLA upper flat file format, the only valid 
data types are 4-byte integers, and 4- and 8-byte floating-point values.  Values from multiple datasets cannot be merged into 
one output file. 
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ASCII files generated from large data sets are potentially enormous, and may appear to lock up  SPLASH for a moment 
while the file is being written.   

3.10 Export Meta File 
 
The Export to Image Menu allows you to generate an image file of your currently active page.   SPLASH supports the 
following file types: Windows Meta-File (.emf, Windows Only).  

3.11 Print 
 
When the Print option is selected under the File pull down menu a print dialog window will be displayed. The default print 
device will be displayed and you can choose the number of copies you would like printed out.  If you do not wish to use the 
default printer listed, please see Section 6.3.11, Printer Setup, which allows you to select from all printers that are recognized 
by your system. In addition, the Printer Setup window allows the user to control additional print parameters.  
 
Figure 3.10 shows an example of the print dialog window. 
 
NOTE Printing can be unreliable depending on your combination of Printer and OS.  If you have any problems 
printing, you should export your document to an Image(EMF or print to PDF) and print directly using your an OS 
specific image viewer.   

 
 

Figure 3.10 
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3.12 Print Setup 
 
The Printer Setup option available under the File pull down menu allows the user to set up print parameters, select print 
devices, and print. The Print Setup option displays the standard print dialog window.  All print devices that your system can 
detect are listed in the Select Printer box. In addition, you can control the number of copies, page range, collating details, and 
preferences associated with the print device you selected. For detailed information about this dialog box and the preferences 
you can set, please refer to the IDL User’s Guide. Figure 3.11 shows the Print Setup window. 
 

 
 

 
 Figure 3.11 

 

3.13 Save Theme 
 
Themes allow the user to save SPLASH layouts without saving any data.  Themes are saved in .THM files, which use 
extensible markup language (XML) files to record the attributes of your plot.  These include page background color, font and 
sizes of numbers, labels, titles, footers, labels, and markers, panel background colors, grid colors and styles for the x and y 
axes,  trace line thickness and colors, marker styles, and variable attributes.  This is a very useful feature if you wish to 
change the default visual style of SPLASH or if there is a publication style that you use very often and wish to preserve.  This 
is different from a .SPH file because it does not include any information about what data to plot, only about how to display it.   
 
When Save Theme is chosen, a File Picker dialog will appear.  Choose the name for your .THM file and select Save (or OK).   

3.14 Load Theme 
 
Load theme will display a file picker box, and you can choose any .THM files you have saved.  See section 3.12 on Themes. 
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3.15 Set Theme 
 
There are three pre-defined themes in SPLASH:  black text on white background, black text on grey background (default), 
and white text on black background.  Once data has been loaded, the user can change themes to any of these.  See 3.12 for 
more information on themes. 
 

3.16 Markers 
 
See section 2.5 for a definition and overview of SPLASH Markers.  The markers sub-menu in the File menu allows users to 
save the locations and styles of markers, export the locations and styles of markers, and to export the data inside of the 
markers.   
 
Import/Export Marker List:  SPLASH saves the location and styles of markers in .MRK files.  These are XML files that save 
the attributes and locations of markers, including the start and stop time, marker color, and marker border style, color, and 
width.   
 
Export Marker Data:  The export marker dialog allows the user to output the data at the start of the marker, end of the marker, 
or within the marker as either an average value or all records.  Simply select which options you would like in the Export 
Marker dialog and hit OK.  Another dialog will appear allowing you to choose which fields you would like to output (default 
is all).  You will be asked for a file name to store the data in, and then SPLASH will perform the export.   
 

 Figure 3.12 
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3.13 Exit 
 
The Exit option under the File pull down menu will terminate the SPLASH session. All windows will be closed and control 
returned to the command line.  
 

4  Edit Menu 
 
The Edit menu contains options that allow the user to copy images or pages and delete or zoom into marked areas. Figure 4.1 
shows the Edit pull down menu selections. 
 

 
 

Figure 4.1 

4.1 Copy 
 
The Copy option in the Edit pull down menu will place a copy of the current or ‘active’ page as an EMF on the clipboard.  
You may also use the accelerator key sequence Ctrl-C to copy the current page. Once the image has been placed on the 
clipboard, the user may paste it into any program, such as a Word document.  

4.2 Delete Marker 
  
If markers exist and one has been selected, the Delete Marker option under the Edit pull down menu will remove the marker 
and redraw the page without the marker. Recall that when a marker is selected, the vertical lines bounding the marked area 
are drawn in pink. If no markers exist, or none have been selected the procedure will do nothing and you can continue with 
other SPLASH operations. 
 

4.3 Subset 
 
The Subset option will create a new page based on the ‘active’ window or the selected marker. This menu item contains two 
sub-menus, Page and Marker.  
 
The first item, Page, makes a copy of the ‘active’ page and pastes that copy into a new page.  The original page is preserved. 
You can use the Window pull down menu to toggle back and forth between pages. 
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The second item, Marker, zooms in to the selected marker. Like with Subset Page, the Subset marker option will create a new 
page, this time containing only the x range that is contained within the marker boundary. The original page is preserved.  
 

4.4 Preferences 
 
This menu option pops up a window that allows access to the system variables that SPLASH and give its defaults. You can 
type in values for the different options in the window.  Tabs at the top of screen allow selection of configuration parameters 
for the different missions that SPLASH supports loading data from. 
 
In the Save tab, the user can specify whether to use relative or full paths to data when saving. 
In the General tab, the user can conFigure gutters, margins, panel outlines, and default file extensions.   
In the ASCII Data tab, the user can set the default time format, default field delimiters, default number of header lines, and 
set limits on how many warnings and errors are tolerated when reading an ASCII file before quitting.  The default flag values 
box allows the user to specify any strings or numbers that are used as flags in the ASCII data, so that SPLASH can then 
recognize it as a flag.  
The Units tab specifies the default units when defining data gaps. 
The Prompt tab allows the user to control how much SPLASH prompts them when performing various tasks.  
The Update tab will check for SPLASH updates automatically.  
The THEMIS tab allows the user to specify their preferred THEMIS data server (the default is ftp://justice.ssl.berkeley.edu,) 
and the local storage directory.  Downloaded data will be stored in the same structure as it is found on the THEMIS server, so 
only the top-most folder is necessary.  If the data is already local, SPLASH will attempt to check if there is a newer version 
available, and if not, will load the data from the local directory, rather than downloading it all again.   
 

ftp://justice.ssl.berkeley.edu/
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5  View Menu 
 
The View menu contains items that modify the look of the main SPLASH window and/or the page and panels displayed in 
the main graph area. 
 

 
 

5.1 Layout 
 
Layout allows the user to view multiple pages at the same time.  1up will show only one page.  2-up will split the screen in 
half and show 2 pages on the screen.  4-up divides the screen into quarters to display up to 4 pages at once.   

5.2 Jump 
 
The Jump menu option displays a box requesting a time to jump to.  In this manner the user can immediately locate a specific 
time in the dataset.  Enter a number and press OK. 
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5.3 Display Markers 
 
Toggles markers on and off 
 

5.4 Refresh 

 
You can use the Refresh option in the View pull down menu at any time to redraw the ‘active’ page. The Refresh option also 
has an accelerator key, Ctrl-R. 
 

5.5 Scroll Forward/Backward 

  
Scrolling can be invoked in three ways, using the Scroll Forward or Scroll Backward option in the View pull down menu, 
using the left and right arrow keys, or by using the scroll icons in the toolbar. A scroll request will move the x-axis forward or 
backward by the range of a major tick. This operation will be done for all panels in the ‘active’ page. 
 
5.6 Expand/Reduce 
 
Similar to scrolling the Scrolling forward can be invoked in three ways, using the Scroll Forward or Scroll Backward option 
in the View pull down menu, using the backspace and tab keys, or by using the expand/reduce icons in the toolbar. A 
expand/reduce request will expand/contract the x-axis of the displayed data by a major tick. 
 
5.7 Path Bar 
 
The Path bar menu options toggles the display of the Path bar.  When it is checked, the bar is displayed.  This is the bar 
underneath the toolbar that displays information about the data file.   
 
5.8 Position Bar 
 
The Position bar menu options toggles the display of the position bar.  When it is checked, the bar is displayed.  This is the 
horizontal scrollbar underneath the path bar that shows where in the dataset you are.   
 
5.9 Status Bar 
 
The Status bar menu options toggles the display of the Status bar.  When it is checked, the bar is displayed.  This is the bar 
underneath the main graph window that gives tooltips and sometimes gives information about what SPLASH is doing.   
 
5.10 Toolbar 
 
The Toolbar menu options toggles the display of the Toolbar.  When it is checked, the bar is displayed.  This is the bar 
underneath the menu bar with buttons that allow quick access to common functions.   
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6  Graph Menu 
 

 
Figure 6.1 

 

6.1 No Panel Tracking 
 
Tracking can be toggled on or off by selecting the No Panel Tracking option under the Graph menu. When tracking is on, you 
will see a vertical bar tracking any cursor movement that occurs inside the frame of a panel. This option is a checked menu 
item. When a check mark is not displayed before the menu item name, No Panel Tracking, then you will see the vertical line. 
When a check mark is present tracking is turned off. By turning off tracking, you also turn off the position legend box in the 
upper right corners of the panels.  This menu item will also turn off the Track One Panel and Track All options. 
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6.2  Track One Panel  
 
The user can choose to turn the vertical tracking line to track only one panel at a time versus all panels. When this mode is 
selected the vertical tracking bar will track only the panel that the cursor is in. This is a checked menu item and is on when 
the check mark is present and off when not. When tracking is in one panel mode, the track all option will automatically be 
turned off and the menu item will be unchecked. The No Panel Tracking/Track One/Track All menu items are mutually 
exclusive so when one mode is on, the others will be turned off.  
 
6.3 Track All 
 
When in track all mode, the vertical line will track the cursor movement in all panels in the ‘active’ page. See section 6.2 
Track One Panel to see how the two menu items are paired.  
 
6.4   Show Vertical Tracking  
 
This menu item will be turned on whenever tracking is on, and off when tracking is off. This is regardless of whether tracking 
one panel or all panels.  It displays a vertical line wherever the mouse is, when the mouse is over a plot, and the values in the 
position legend update according to the position of this line. 
 
6.5 Show Horizontal Tracking  
 
Horizontal tracking creates a horizontal line wherever the mouse goes.  If vertical tracking is turned on as well, there will be a 
crosshairs that move over the data.  The position reporting boxes will update to show the values of the data under those 
crosshairs.   
 

6.6 Track Additional Variables 
 
This menu item turns on the tracking of variables down at the bottom of the screen.  The tracking will appear in red font to 
the far right of the plot next to the x-axis. 

6.7 Page Options  
 
The Page Options window controls settings global to the current page. To open this window Select Page Options in the 
Graph pull down menu or single click anywhere on the page of SPLASH that is not occupied by variables, plots, or axes. 
 
The Text tab (shown below in Figure 6.2) lets the user choose the settings for size, font, and color of the title, variables, and 
footer.  The ‘Token…’ buttons let the user insert a time stamp with a variety of formats into the title/footer (note that 
SPLASH inserts the token at the current location of the cursor).  The ‘Format…’ buttons change boldface and italic settings.  
The Font Style frame controls font, font size, and font color (a color dialog box opens – see Figure) for both title and footer.  
Use the Show check boxes to hide or show the title and footer. 
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Figure 6.2 
 
 
The available token options are Time, Date, Year, Day of Year, Page Number, Total Pages, File Name, and Data File Name. 
 
The Layout tab (shown below in Figure 6.3) has five active frames: Panel Arrangement, Margins, Gutter, Orientation, and 
Background.  Panel Arrangement: The horizontal and vertical panel spacing sets the horizontal and vertical distance between 
columns and rows (respectively) of the panels.  Margins: The top, left, right, and bottom margins set the distance (in inches) 
from the corresponding edge of the canvas to the nearest panel.  The margins must be at least 0.1 inches.  Orientation: 
Portrait or Landscape.  Gutter: Distance between panels. 
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Figure 6.3 

 

Finally, the Data tab is pictured in Figure 6.3.  In the data tab you can set how much overlap you want between pages when 
you page up and page down (ie, when scrolling through the data manually).  You can also set whether all plots on a page 
should have the same Y-value when autoscaling is on.   
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Figure 6.4 

6.8 Panel Options 
 
The Panel Options window (Figure 6.5) allows the user to modify the layout, spacing, and color of the panel and traces 
therein.  The panel options dialog can be reached in 3 ways: The Graph -> Panel Options menu, by right clicking a panel and 
choosing Panel options, and through the Layout Dialog, which will be discussed later.   
 
The Panel Options dialog has three tabs: Trace, Layout, and Grid.   
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Figure 6.5 
 
The Trace Dialog allows you to pick which trace you would like to edit.  First the user may pick a panel.  If you entered via 
right clicking on panel, that one is selected by default.  Otherwise, the first panel on the page is selected.  All traces in this 
panel are automatically added to the Trace box below.  The Clip frame allows you to specify if SPLASH should clip the trace 
if it goes outside of the y-axis range or just draw it.  By default, all clipping is turned on.   
 
When you select a trace in the trace frame, it will tell you what color and weight the line is drawn in the short description.  To 
remove the trace, click on the Delete button.  To set all the other traces to have the same properties as this current trace, click 
Set Same.  To add another trace, click the add button.  And to change the line weight, color, or any other property, click on 
the edit button.  The Add and Edit buttons will bring up the Trace Properties dialog. 
 
The Trace Properties dialog has 3 tabs: Line, Spectra, and Highlight. The LineTab is showed in Figure 6.6.   
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Figure 6.6 
 
The Line tab allows the user to customize every line trace in SPLASH.  The x-axis and y-axis pull-down menus allow the 
user to change what is plotted.  Once a trace is selected each widget will be updated to show the current settings for that trace. 
Line and symbol settings, as well as symbol frequency can be modified on this window.   If “Add” was clicked in the Panel 
dialog, this is the place to specify what you want to add.   
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The next section contains 2 frames: Line Options and Symbol Options.  If the Show Line buttons is checked (default) 
SPLASH will display the data as a continuous line, interpolating between points.  If the Symbol box is checked, SPLASH 
will place a symbol at each actual data point.  SPLASH can display line only, symbol only, or both.  The Line Options frame 
allows the user to specify whether the line is displayed, color, style, and weight (thickness).  The Mirror check box will add 
another trace to the panel which is mirrored across the X-axis.  The Symbol Options frame allows the user to customize any 
symbols they may add to the graph.   
 
Line Modifications  
 

Show: The show check box determines whether the line is displayed or not. A check indicates the line will be 
drawn. 
 
Mirror:  The mirror check box will draw a horizontal line at zero and reflects the trace across this line.  
  
Color: The color button will allow the user to select a different color.  

  
Style: The line style drop list contains all the line styles that SPLASH allows (e.g. dashed, dotted, etc..).  
 
Thickness: The thickness spinner widget lets the user change the size of the line.  
 

Symbol Modifications 
 

Show: The show check box will determine whether the symbol is displayed in the plot, or not. A checked box 
indicates the symbol will be drawn. 
 
Fill: Fill has not yet been implemented, however, when checked the symbol will be filled in with the selected color. 

 
Style: The symbol style drop list lets the user choose any of the symbols that IDL allows. 
 
Color: The color button will open the color palette allowing the user to select a different color. When a new color 
has been accepted the current color swatch next to the button will be updated to reflect t the Apply or 
OK buttons are clicked the symbol will be drawn in the new color. 

he change. If Figure 6.6.8 

 
Size: The size spinner allows the user to increase or decrease the display size of the symbol. 

Symbol frequency has five options for determining when a symbol is drawn and include:  First Point, First and Last Point, 
Last Point, Major Ticks, or Every x points. If the Every x points button is clicked a numeric value can be specified in the 
spinner widget (e.g. a value of 20 will plot a symbol every 20th point).  

As with all graph options windows, the user can click the OK, Apply, or Cancel at any time 

 
SPLASH, when drawing lines, will interpolate even across large data gaps, but sometimes it is nice to see if there is a large 
data gap.  In order to tell SPLASH to only connect lines if the gap is smaller than a given interval, the user can use the “Do 
not draw lines between points” checkbox.  By specifying an interval in the textbox, SPLASH will not draw lines across gaps 
longer than that interval.  By clicking the Set All button, this setting will apply to all plots on the page. 
 
Bars can be used to create error bars or if there is any other reason you want bars coming out from the top and bottom of your 
trace.  In order to set error bars, simply click the Bars checkbox and use the drop down menus to specify the fields that 
contain the error bar sizes.  An error bar will be overlaid on each point.  Using the Style and End mark frames inside the bar 
frame, the user can customize the appearance of the error bars. 



 
 

 SPLASH User’s Guide   39 

The Spectra tab of the Trace Properties dialog (fig 6.7)allows the user to customize the appearance of spectral data.  Again, 
the top three drop down menus allow the user to specify what is plotted along the x,y, and z axes.  If the plot is a line plot, no 
Z data will be selected.   
 
 

 
 

Figure 6.7 
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The Color table frame contains pre-defined color bars.  They come in many pretty colors.  With this dialog you can also 
specify whether the z-axis (ie, the colorbar) uses a linear or log scale and the range.  The Guess button will try to find the 
minimum and maximum contained in your data and set those as Minimum and Maximum in the plot.  The Placement Frame 
allows the user to specify where the colorbar will be displayed.   
 
I have no idea what the Highlight tab does.  It seems to make my plot sad.  
 
That concludes the Trace Tab of the Panel Properties dialog!  Now onto the Layout tab!  It can be seen in Figure 6.8.  
 

 
 

Figure 6.8 
 
The layout tab allows the user to give Titles to individual Panels, to specify the placement of panels exactly, to set the colors 
of each panel’s background, and to Overlay one Panel on another.  To Overlay, select the panel you would like to overlay on 
your currently selected panel and click ok.  It may require some fiddling with the Row/Column spin dials to work.   
 
Finally, we have the Grid tab of the Panel Properties dialog (fig 6.9).   
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Figure 6.9 
 
Using the Grid tab, a user can specify the appearance and frequency of grid lines.  Major grid lines appear where the x-axis is 
annotated with a value.  The minor grid lines are where the minor ticks appear on the x-axis.  Tick-spacing can be further 
specified in the Ticks tab of the axis settings dialog, discussed later.   

6.9 Layout Options 
 
The Layout Options window allows the user to create panels and select data values for display on those panels. Panels can be 
added, deleted, and reordered. In addition, settings associated with panels and traces can be modified. 
 
The left hand side of the window is used for selecting the independent and dependent variables to be used in plots. The right 
hand side of the window is for manipulating panels. If no data has been loaded or panels created both these text areas will be 
blank. The Variable section at the bottom of the window allows the user to select variables for display below axes. 
 
To add a line plot, select the data that you want to add and select the Add> button.  If no panels exist, one will be created 
automatically and named, Panel 1(1,1).  When first opening a new data file, a new panel will automatically be added each 
time you press the Add> button in the center.  However, if you wish to add a new panel manually, use the Add button to the 
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far right.  As a general rule, if you have more than one dataset loaded, or one dataset that has different time cadences, make 
sure that your X values are valid for the Y values you choose.  Otherwise SPLASH will be very upset! 
 
 
 

 
 
 
To add a Spectra plot, click the Spectra button.  NB: THE SPECTRA BUTTON DOES NOT APPEAR UNTIL YOU HAVE 
PLOTTED SOMETHING ONCE.  THEN YOU CAN OPEN THE LAYOUT OPTIONS AGAIN AND THE SPECTRA 
BUTTON WILL BE THERE.  The Spectra Layout options dialog (Figure 6.11) works just like the line layout box, but it the 
user can specify X, Y, and Z axes.  In the Spectra box, if there is a tree, use the top of the tree to select all things under it.   

Figure 6.10 
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Figure 6.11 
 
As new panels are added the panel number will increase sequentially, regardless of whether earlier panels were deleted or 
reordered. The row and column numbers are displayed in parenthesis next to the panel number.  It is important to note that 
Panel numbers do not change, however, row and column values can 
 
The user can choose to delete a panel or trace by selecting (or highlighting) the item in the panel text box and clicking delete. 
Further, the user can modify panel or trace settings by selecting the item and clicking the Edit button.  See section 6.8 for 
additional details. 
 
The Up and Down arrow buttons provide a way to reorder panel rows or trace location on the panel. The left and right arrow 
buttons move panels by column. Panels can be overlaid, in other words, they can have the same row and column number. The 
user needs to be aware of this feature when reordering so that care can be taken to ensure the correct layout is created.  
 
The row and column number of a panel can be changed using the Row and Column spinner widgets below the arrow buttons. 
The total number of rows and columns per page can also be modified. Please note that the total number of page rows and/or 
columns cannot be set to a value less than the largest row and/or column value (e.g. Panel 4(5, 2) – Panel 4 is displayed in 
row 5, the user cannot change the total rows to any value smaller than 5, likewise, in this example, total page columns must 
be greater than or equal to 2). 
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While SPLASH is most often used to plot data vs time, time does not HAVE to be on the x axis.  SPLASH supports any 
value along the x-axis. 
At any time the user can click the Apply button to view the panel layout, the OK button to commit the layout, and close the 
window, or Cancel to undo changes and close the window. 
 
At the bottom of the Layout Panel is a variable section. The text box will display any variables that have been chosen for 
display below the x-axis. The user can also click the Add/Edit button to bring up the Variable Options window. See section 
6.6.10 for details on creating variables for display.  
 
When a trace (or line) is highlighted in the panel window and the Edit button clicked the Line Options window will be 
opened. The Line Options window allows the user to modify any settings that are associated with plotting the line. If a panel 
is highlighted in the panel window of the Layout dialog and the Edit button is clicked, the Panel Options window will be 
opened.  See section 6.8 for more information on the Panel and Line Options dialogs. 
 

6.10 X/Y Axis Options  
 
The X-Axis Options window (Figure 6.12) controls the x-axis settings for the selected panel (use the panel drop down menu 
at the top of the window to change the selection).  To get X-Axis Options, select it from the Graph pull down menu or single 
click on the X-axis. Accepting and canceling changes: Clicking OK accepts the changes and refreshes the page.  Clicking 
Apply accepts the changes provisionally and refreshes the page.  Clicking Cancel rejects any changes and refreshes the page.  
Dismissing the window via the operating system (‘X’ button) has the same effect as clicking Cancel. 
 
The Range tab sets how SPLASH determines the displayed range and gives a special option for when the axis displays time.  
If the axis is time, then the ‘Is Time’ check box should be set.  When the axis is time, then only the fixed Min/Max frame, 
and the Set All Panels button are active.  (A note about Set All Panels: This button works individually for each tab.  Any 
operations done on a given tab after setting the button will propagate to all panels.)  When the axis is time, SPLASH 
represents the Min/Max range in date/time format.  When the data is not time (uncheck Is Time), the Range and Scaling 
sections become active.  The Range Options buttons now make active (only one at a time) the following frames: Auto Range, 
Floating Center, and Fixed Min/Max. 
 
Auto Range: The range margin sets a margin between the plotted data and the plot box edge (above and below) as a 
percentage of the maximum minus the minimum of the displayed data.  The bound auto-scaling range puts absolute limits on 
how big the range can get; auto-ranges fully within the bounds are unaffected.   
 
Floating Center: SPLASH determines the center as a mean, or median of the data (to be selected in the Floating Range frame 
of the dialog.).   If the axis uses linear scaling then floating range is calculated using the following equations.  Minimum 
Range = center – span,  Maximum Range = center + span.  If the axis uses logarithmic scaling then the floating range is 
calculated using the following equations:  Minimum Range = base ^ (log(center) – span), Maximum Range = base ^ 
(log(center) + span).    In other words, the span of the floating center on a logarithmic plot is the number of orders of 
magnitude above and below the center that should be included in the plot. 
In the equation above 'base' is either e or 10, and 'log' is either the natural logarithm or the base 10 logarithm, depending upon 
the type of log scaling that is used. 
 
 
If the axis is Fixed Min/Max: The user determines an absolute range.   
 
Scaling: The user can select linear, logarithmic base 10, or natural logarithmic scaling. Figure 6.6.9a shows the Range Tab of 
the X/Y Axis Options window. 
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Figure 6.12 
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The Ticks tab (Figure 6.13) sets where and how to draw the axis ticks, and contains two frames for Placement and Length 
The user can choose to manipulate ticks by number, or by interval. When the ‘Major Ticks by Number’ radio button is on, 
the user can modify the number of ticks in the spinner. .  By default, SPLASH determines ticks automatically, however, the 
user can toggle this feature on or off.  Alternately, the user can elect to manipulate ticks by interval. When the ‘Major Ticks 
by Interval’ button is on, the user can enter the number, the units, and/or the specific time at which to align ticks.  If the axis 
is time, ‘Units’ sets the tick frequency in common time units, otherwise the units widget is not active. The ‘Draw Ticks’ drop 
list provides for different tick style’s and includes drawing the tick inside the panel frame, outside the panel frame, or both. 
The Placement frame has right and left buttons that switch ticks on/off for the right and left y-axes of the plot box.  The 
Length frame controls the lengths of the major and minor axes. Figure 6.6.8b shows the Ticks Tab of the X/Y Axis Options 
window. 
 
Tick options will be measured in orders of magnitude of data units if the axis is logarithmically scaled and data units if the 
axis is linearly scaled.   
 
NOTE:  When auto-ticks are chosen the number of ticks is an upper bound. The actual number of ticks will be determined 
based on the range of the data.  
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 Figure 6.13 

 
  
 
The Annotation tab (Figure 6.14) allows control over annotation settings for the major ticks.  This tab can also draw a single 
line at axis zero, or at 1 for logarithmic scaling (checkbox).  The user can also choose to annotate the first and/or the last tick 
(‘Annotate first’/’Annotate last’).  (Note that the first/last tick often coincides with the edges of the plot box.)  Check 
‘Annotate Along Axis’ to control the placement (top or bottom x-axis), frequency, orientation, font, font size, and color of the 
annotations.  Other annotation options include where to place the annotations, orientation, font type, size and color. 
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Annotation options for numerical data include auto formatting, decimal notation, and scientific.  Auto format will determine 
if the number can be displayed in decimal format with the selected number of significant Figures (Annotation Precision 
dropdown).  If not, then the number will be printed in scientific notation.  When forcing to decimal notation the Annotation 
Precision dropdown will designate the number of places printed after the decimal, not significant Figures.  Trailing zeros are 
automatically clipped by the software (i.e. “10.00000” is printed as “10”).   For time axes the Annotation Format dropdown 
has a variety of format options.  All of these options are contained in the Annotation style dropdown and the appropriate type 
(numerical or date) will be selected, though any version is possible. 

Figure 6.14 

 
The Labels tab controls what axis labels say and how they are formatted.  The Position frame sets orientation and margin 
(globally to the given axis and panel) while the text frame allows the user to specify the text of the label and the color of the 
text.  For other font and size settings for labels, please refer to the section on Page Options. The Labels Tab on the X/Y Axis 
Options window is shown below in Figure 6.15. 
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Figure 6.15 
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6.11 Z Axis Options 
 
The SPLASH allows graphing of three-dimensional spectral quantities from the spacecraft as well as ground-based 
keograms.  See the Section 6.9 Layout Options for details on graphing spectra. The second panel in Figure 6.14 shows an 
example of spectral data. 
 

 
 

Figure 6.14 
 
Once spectral plots are created their extra display features and parameters can be edited in the Z Axis .  It is possible to access 
the Z-axis options by clicking on the graph’s colorbar or through the Panel Options menu, discussed above.  Options for the 
X and Y-axes are still functional and can also be found under the Graph pull down menu. 
 
Settings: 
 
The Settings tab (Figure 6.15) contains display and annotation options.  The Panels drop list contains all plots in the active 
page that have z-axes.  
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 Figure 6.15 
 
 
Color Table:  The color table section allows the user to change the color scheme being mapped to z-axis values on the active 
panel.  A preview of the current selection can be seen on the right.  The color bar represents numerical values in decreasing 
order from top to bottom. Colors are mapped to numerical values according to the chosen Scaling. 
 
Scaling:  Determines how the selected Color Table is mapped to z-axis values.  Values within the range are assigned linearly 
by default but can be assigned according to a base-ten or natural logarithmic scale. 
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Placement:  Sets the position of the Color Bar (see fig. 6.6.10a).  The Color Bar displays the color scheme of the associated 
panel plus numeric annotations for scaling. 
 
Range:  The z-axis range is automatically calculated by default and the color table is mapped with the selected scaling.  
Checking the Fixed Min/Max box allows the user to specify the maximum and minimum values for the plot.  Values above or 
below the limits are respectively assigned the color corresponding to the maximum or minimum value. 
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6.12 Variable Options 
 
The Variable Options window (see Figure 6.16  below) lets the user add variables beneath the selected panel.  To get 
Variable Options, select it from the Graph pull down menu or single-click on the variables in the main SPLASH window. 
Accepting and canceling changes: Clicking OK accepts the changes and refreshes the page.  Clicking Cancel rejects any 
changes.  Dismissing the window via the operating system (‘X’ button) has the same effect as clicking Cancel.  Hitting 
"cancel" will undo applied changes. Figure 6.16 shows an example of the Variable Options window.  
 
Note that formatting options for the variables (font, style, color) are controlled from the page options window. 
 

 
 Figure 6.16 
 
The box on the left contains the names of all the current variables shown on the current page.   
 
The Attributes frame: The Field attribute shows the proper data name of the variable and never changes.  The Control 
attribute shows which data name represents the abscissa for the variable.  By default, SPLASH sets the control to the time 
data for the Field.  The Text attribute changes the name of the variable as displayed in the Variables frame on the left and on 
the plotted panel. The Units attribute changes the units displayed in the Variables frame on the plotted panel.  The symbol 
drop down menu allows you to add things like the degrees symbol, for the Units.  The Format attribute sets the format of the 
variable annotations (time formats for time variables, floating formats for numeric variables).  The color attributes set the 
color of the selected variable.  Use the ‘Remove’ button to remove a variable from the plot. 
 
To add variables, click the add button (‘+’).  The ‘Add Variable(s)’ dialog appears with a list of the current fields.  Select the 
field you want to add.  Shift-click or ctrl-click to select ranges or elements.  Click OK to accept the selections, or Cancel to 
start over.  Any selections now appear in the Variables frame on the left.  Set the Control variable for your new additions, as 
this is NOT done automatically.  Click OK to accept and have these variables appear below the current panel, or Cancel to 
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exit Variable Options with no changes.  The user may also select a variable (click on it) to change its attributes (see the 
Attributes frame on the right), to delete it (‘Remove‘ button), or to change its position in the list (up and down arrows).  The 
Label Margin (below Attributes) changes the margin between all variables (for the selected panel) and the left y-axis of the 
plot box, and also changes the margin between the variable legend and the right y-axis of the plot box. An example of the 
Add Variable window is shown below in Figure 6.17. 
   

 
 

Figure 6.17 



 
 

 SPLASH User’s Guide   55 

7  Analysis Menu  
 
The Analysis pull down menu contains selections that allow you to perform various functions on data. Figure 7.0 shows the 
Analysis Menu options. 
 

 

Figure 7.0 

 

7.1 Calculate 

 
The Calculate Window allows you to access a built in language that will perform simple operations on SPLASH data   
Commands for the language can be typed into the text box on the right.  Each line will be treated as a separate line.  If you 
want to insert a particular data quantity, just select the quantity from the ‘Insert Field’ menu at the upper left and the quantity 
will be added to the program text box.  You can also insert variables that store the values of numerical constants by selecting 
them from the ‘Constant’ drop list in the upper right.   
 
Calculate recognizes the following symbols and function names: 
+   add     ^   exponent 
-    subtract    %  mod 
*   multiply    ( ) parentheses  
/    divide 
 
=   logical equals 
<   logical  less than 
>   logical greater than 
|     logical or 
&   logical and  
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exp( )    exponential  sqrt( )    square root  fabs( )   absolute value   
sin( )     sine   asin( )    arcsine   sinh   hyperbolic sine 
cos( )    cosine   acos( )   arccosine  cosh( )    hyperbolic cosine 
tan( )     tangent   atan( )    arctangent 
        
ceil( )  ceiling   floor()   floor    
log( )   natural log  log10( ) log base 10 
 
NB: PROGRAMS MUST END IN A SEMICOLON (;) IN ORDER TO EXECUTE PROPERLY.  Also the calculate 
function is often buggy, so use with caution.  The calculate function does not like negative numbers, but will accept (0-1) to 
act as a negative 1.  All known bugs are being worked on for future releases. 
 
To start a new program, click the New button.  To create a new variable to store your results, click the New Field button.  Fill 
out the new Field name (required) and Units (optional) and press OK.   
 
When you are ready to run the program, select the 'Run' button at the bottom and the Calculate program will be executed.  
Any quantities that are created will be automatically loaded into SPLASH and can be displayed via the Layout Dialog.   
 
To exit this window, click on the 'X' in the upper right hand corner of the window or the 'OK' button at the bottom of the 
window. The Calculate window is shown in Figure 7.1.  
 

 
 

Figure 7.1 

7.2 Nudge  
 
The Nudge Traces option allows the user to “nudge” a trace on a line plot.  “Nudging” simply shifts the given trace by a 
specified amount of time. To activate, select “Nudge Traces” from the “Analysis” pull-down menu. Note that you need to 
have created a page and panel and plotted some data before anything will happen when you make this selection. If there has 
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been data plotted, then a window will pop up, allowing you to select the panel, and trace that will be nudged. An example of 
this window is shown below. There are two drop-down menus that allow you to select the panel and trace that will be 
nudged. The units (time units or records) are selected on the right side of the panel; in the example the shift will be given in 
hours. The number of hours (or minutes, or seconds, etc…) can be selected in the window below the trace selection window. 
Note that you can type a value into this window as well as use the arrows on the side to scroll values.  
 
When the “Apply” button is clicked, the trace is shifted.   A new variables is not created, but it is easy to return to the original 
variable by setting the Amount that the plot has been nudged to 0.  The Nudge All Panels button can be used to apply the 
same nudge to all panels with the same trace name. 
  

 
 

Figure 7.2 
 
Warning:. If you are attempting to nudge a spectrogram then you may get unpredictable results when the plot shows up.    
 

7.3 Data Flow 
 
When you click on “Data Flow” on the Analysis pull-down menu on the Main SPLASH, you can choose whether to apply the 
data flow to the current page or to your entire document.  The Data Flow plugin needs extensive testing and further 
documentation.   
 
The UCLA data flow system is a powerful tool that allows the user to build “blueprints” of actions to perform on data, such 
as reading files, degapping, deflagging, merging files, removing columns, and writing files.    
 
To use the Data Flow plugin, you can build a blueprint by double clicking on the various fittings and then press the RUN 
button.   
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Figure 7.3 
 

7.4 Correlation 
 
The correlation menu item is only active when a marker has been selected.  The correlation will be performed on the marked 
region.  A variable will be created with the prefix “cor-“(by default, but configurable) and ending in the “testing field”.  This 
variable will contain the correlation coefficient when plotted. 
 
The correlation dialog allows you to specify which fields to correlate.  SPLASH allows the user to correlate many fields with 
one source field.  It will not output a value unless the correlation coefficient falls within the parameters specified.   
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Figure 7.4 

7.5 Data Statistics 
 
The data statistics menu item is only active when a marker has been selected.  When selected, it will pop up a window telling 
you the number of points, average, standard deviation, minimum, and maximum of that dataset for each trace within the 
marker.   
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Figure 7.5 

7.6 Fit 
This process performs a fit to the data. A window will pop up providing options for this operation.  On the left hand side is a 
box containing all the different traces.  You can select which traces you want to fit.  A new variable is created for each trace.  
On the right are the options for performing the fit.  You can choose between 4 types:  
 
Running Average:  If a running average is chosen as the fit method, the user can specify the window over which to average 
and whether the window should move or not.  The default is 60 points.   
 
Polynomial:  If a polynomial trace is selected as the fit method, the user can specify the window size (in points) and the 
degree of fit (maximum 10).  The user can also decide if it wants to fit the entire dataset or have a moving window.  
Sometimes it is of value to know the coeffcieints of a polynomial fit, and if the “Save coefficients to file” checkbox is 
checked, a file picker window will appear asking for a place to save the coefficients.  The coefficients will be saved and a 
new variable will be created.   
 
Taper:   If a taper fit is selected as the fit method, the user can specify the length of the taper (in points).  The default is 60 
points.  The user can also decide if it wants to fit the entire dataset or have a moving window.   
 
Gaussian:  If a Gaussian fit is selected as the method, the user can specify window and degree of fit.  The user can also decide 
if it wants to fit the entire dataset or have a moving window.   
 
The “Display Perturbation” Option will show the difference between the fit and the original data, like a high pass filter.  The 
“Add Results to Existing Panel” button will add a trace to the panel for each fit that was performed.  If the data is not added 
to the panel, the new variables are still created and can be accessed in the Layout dialog.   
 
Select "Ok" to process data.   "Cancel" or "X" will close the window without processing. 
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 Figure 7.6 

 

7.7 Filter 
 
This menu option allows the user to apply a filter to the data. A window will pop up providing options for this operation.  On 
the left hand side is a box containing all the different traces.  You can select which traces you want to fit.  A new variable is 
created for each trace.  On the right are the options for performing the fit.  You can perform high pass, low pass, band pass, 
and band stop filters.  There are several different methods:   
 
Boxcar:  A boxcar filter is applied to the data.  Similar to the running average above.  The user supplies a frequency or a 
maximum and minimum frequency.   
Despike: A median filter excellent for removing wayward points.  Consider it a “running median” fit, similar to the running 
average but taking the median value instead of the mean.  The user supplies a frequency or a maximum and minimum 
frequency. 
Gaussian: A Gaussian filter.  The user supplies a frequency or a range of frequencies and a sigma.  
 
Select "Ok" to process data.   "Cancel" or "X" will close the window without processing. 
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Figure 7.7. 
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7.8 Fourier Transform 

This menu option allows the user to fourier transform the data. A window will pop up providing options for this operation.  
On the left hand side is a box containing all the different traces.  You can select which traces you want to fit.  The right side 
of the dialog allows you to specify the options for the transform including the points in the FFT, whether you want to do a 
running average, the window type (rectangular, barlett, Blackman, etc).  The user can also specify the output in real or 
imaginary components, as well as power, power density, amplitude, phase, and amplitude density outputs.  Note: You cannot 
output real and imaginary components with other components.   

  
 

Figure 7.8 
 
A new page will open within the SPLASH main window with the results of your analysis.  These windows work like any 
other SPLASH window. 
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Figure 7.8a 

7.9  Hodogram 
This menu item creates a Hodogram of the data.  A hodogram plots one value vs another value.  To make a hodogram, the 
user must enter a time range and the time and x,y, and z coordinates to use.   It is possible to tell SPLASH to subtract the 
average of each dataset by clicking the “Subtract average of data” checkbox in the Options frame.  NOTE: In the Hodogram 
calculations, the “Magnitude” is the point-to-point “distance” between the X and Y components.  “Area” is the point-to-point 
coverage.   
 

 Figure 7.9 
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Figure 7.9a 

7.10 Minimum Variance 
SPLASH can perform a minimum variance analysis and outputs the eigenvalues and eigenvectors as well as applying them to 
the data.  The best way to perform a minimum variance is to choose Analysis-> Minimum Variance-> Calculate from the 
main SPLASH menu.  That will bring up the minimum variance dialog.  
 

 Figure 7.10 
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Simply select the desire time range and the variables you wish to transform.  Then click apply to see the results of the 
calculation.   To Apply these results to the data, go to Analysis -> Minimum Variance -> Apply.  This will allow you to apply 
the transformation to the data you calculated it for, as well as any other set of vectors.  Useful!  To undo the application of the 
minimum variance eigenvectors, just pick Analysis -> Minimum Variance -> Unapply. 
 

7.11  Marker Wizard 
The Marker Wizard is a nifty tool for finding data and placing markers automatically that fulfill certain conditions.   The 
“Use” dropdown menu is usually “time” but can be anything you want.  It is what is used to set the start and end points, so a 
monotonically increasing or decreasing list (or at least something with unique values) is optimal.  The user can then define 
markers to start whenever they want.  As an example, I would like to put a marker when the spacecraft is within 12 planetary 
radii of my target and within 5 degrees latitude from the equator.  I just fill out the boxes (see example!) and hit OK.  The 
user can also design their marker to look however they want using the wizard!  Hooray!   
 

 
 

Figure 7.11 
 
After these markers have been placed, it is possible to output just the data within the markers (great, if you only want to study 
that region!) or the start and stop times of the markers (useful if you only need to know when that was happening!) using the 
Markers > option in the File menu.  See above for details.   

7.12 Derivative 
This process takes the  derivative of the active panel.  It uses the data plotted on the x and y axis as its inputs and does a point 
by point difference. 
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7.13 Spectral Analysis   
 
When the Spectral Analysis menu button is clicked a new window will be opened containing two tabs: the Dynamic Spectra 
tab and the Waves tab.  The dynamic Spectra tab contains power spectral parameters that the user can manipulate. The user 
can select window size and shift, time range and how the data is to be binned.  Note that this is designed for data that are 
either of a linear data type. Applying this to other data (e.g., spectrograms) will cause non-intuitive results.  
 
 

 
 Figure 7.12 
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Figure 7.13 
 
 
The Waves tab will bring up the Wave Analysis dialog.  Here the user can input the components to use the 
analysis, a time range, and specify what SPLASH should output.  A sample output is below.   
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 Figure 7.14 
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8 Window Menu 

The Window pull down menu contains options to open, close and toggle between pages. It is a standard windows menu 

9    Help Menu 
 
The user can view a text version of this document or create a help request form. Figure 6.9 shows the Help pull down menu 
options. 
 

 
 

 Figure 9.1 

9.1 Help Topics 
 
Clicking on the Help menu and selecting Help Topics will open a dialog box that will provide you with the URL for the 
online User’s SPLASH document.  It also contains a brief tutorial on what SPLASH is and a QUICKSTART Guide showing 
how to use SPLASH with PDS.   
 

 
 

Figure 9.2 
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9.2 Check for Update… 
 
When this button is clicked, SPLASH checks to see if there is a new update. 
 
9.3 About SPLASH 
When the About SPLASH menu item is selected a window will open with a splash SPLASH screen, showing the version, 
copyright information, and developer credits.   
 

 
 

Figure 9.3 
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